
i 
 

TeleReader Configurator 

Contents 
TeleReader Configurator Main Screen .......................................................................................................... 1 

Acquisition Site Setup ................................................................................................................................... 1 

TeleReader Unread List page .................................................................................................................... 1 

TeleReader Unread List Add/Edit Dialog............................................................................................... 2 

Modality Worklist Page ............................................................................................................................. 3 

Modality Worklist Add/Edit Dialog ....................................................................................................... 4 

Reading Site Setup ........................................................................................................................................ 6 

Acquisition Sites Page ............................................................................................................................... 6 

Acquisition Site Add/Edit Dialog ........................................................................................................... 7 

Readers Page ............................................................................................................................................. 8 

Add Readers/Privileges dialog .............................................................................................................. 9 

Activate/Deactivate Privileges .............................................................................................................. 9 

Cloning TeleReader Profiles ................................................................................................................ 10 

Global Settings ............................................................................................................................................ 13 

System Help ................................................................................................................................................ 14 

Message Log ............................................................................................................................................ 14 

About Box ................................................................................................................................................ 15 

Field Help Text ........................................................................................................................................ 16 

 

 

 



1 
 

TeleReader Configurator Main Screen 

 

From the TeleReader Configurator Main Screen, the reader has options to set up TeleReader settings 

relevant to an Acquisition site, a Reading Site or both (Global Settings). The reader can also view the 

System Log or About box (from the File menu). The main screen title bar displays the login server in 

parentheses. 

Acquisition Site Setup 

From the Acquisition Site Setup screen, the reader can view/add/edit/delete records from the 

TELEREADER ACQUISITION SERVICE file (#2006.5841) on the TeleReader Unread List page or 

view/add/edit/delete records from the DICOM HEALTHCARE PROVIDER SERVICE file (#2006.5831) on the 

Modality Worklist page. 

TeleReader Unread List page 
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The TeleReader Unread List page displays records in the TELEREADER ACQUISITION SERVICE file 

(#2006.5841)in a listview.  The bottom panel shows the detail of the selected record. The reader can add 

a new record or edit/delete an existing one. 

TeleReader Unread List Add/Edit Dialog 

 

The TeleReader Unread List Add/Edit dialog gives the reader the ability to add a new/edit an existing 

record from the TELEREADER ACQUISITION SERVICE file (#2006.5841) by choosing values from drop-

down lists. In Edit mode, the Service Name combo box is disabled. The Procedure drop-down list will be 

a subset of the chosen Service Name. The Procedure/Event index drop-down list will be a subset of the 
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chosen Specialty Index.  In Add mode, the Acquisition Site defaults to the Login Site and the Unread List 

Trigger defaults to (I) – Create/Update With Every Acquired Image.  

Modality Worklist Page 

 

The Modality Worklist page displays records in the DICOM HEALTHCARE PROVIDER SERVICE file 

(#2006.5831) in a listview.  The reader can add a new record or edit/delete an existing one. 
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Modality Worklist Add/Edit Dialog 

 

The Modality Worklist Add/Edit dialog gives the reader the ability to add a new/edit an existing record 

from the DICOM HEALTHCARE PROVIDER SERVICE file (#2006.5831) by choosing values from drop down 

lists and the Select Clinic(s) dialog. In edit mode the Service Name combo box is disabled. To select one 

or more clinics click the ‘Clinic List’ to the right of the Clinic(s) list box. 
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Select Clinics 

 

The reader can select clinics from the Available Clinics listbox to the Selected Clinics listbox by double 

clicking an item in the Available Clinics listbox or by selecting that item and clicking the (>) button. To 

deselect a clinic from the Selected Clinics listbox double click that item or  select  the item and click the 

(<) button. Click OK for make the selection or Cancel to disregard the selections. 



6 
 

 

Reading Site Setup 
From the Reading Site Setup Screen the reader can view/add/edit/delete records from the TELEREADER 

ACQUISITION SITE file (#2006.5842) on the Acquisition Site page or view/add/edit/delete records from 

the TELEREADER READER file (#2006.5843) on the Readers page. 

Acquisition Sites Page 
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The Acquisition Sites page displays records in the TELEREADER ACQUISITION SITE file (#2006.5842) in a 

list view.  The reader can add a new record or edit/delete an existing one. 

Acquisition Site Add/Edit Dialog 

 

The Acquisition Site Add/Edit dialog gives the reader the ability to add a new/edit an existing record 

from the TELEREADER ACQUISITION SITE file (#2006.5842) by choosing values from drop down lists, a 

check box for Active and an edit box for Consult Lock Timeout. In Edit mode the Acquisition Site Combo 

Box is disabled.  
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Readers Page 

 

The Readers page displays records in the TELEREADER READER file (#2006.5843) in a tree view.  The 

reader can add/delete new readers, add/delete privileges for those readers (Acquisition Sites, Specialty 

Index, Procedure Index) and activate/deactivate those privileges. The tree view can be collapsed by 

clicking the (-) button and expanded (as shown in the image above) by the clicking the (+) button. 

To add Privileges, the reader selects the tree view node for he/she wants to add a privilege to. For 

Example if the user wants to add a new Acquisition Site/Specialty Index/Procedure Index for a Reader, 

select that Reader’s node and clicks the Add Privilege button. If the reader wants to add a new 

Procedure Index for a Reader’s Acquisition Site/Specialty Index, the reader selects the Specialty Index 

node and clicks the Add Privilege button. 
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Add Readers/Privileges dialog 

 

The Add Reader/Privilege dialog gives the reader the ability to add a new Readers/Reader Privileges to 

the TELEREADER READER file (#2006.5843) by choosing values from drop down lists. When adding a new 

Privilege, the Reader and any parent Privilege is disabled. For example when adding a new Specialty 

Index, the Reader and Acquisition Site combo boxes will be disabled.  

When adding a new Reader, enter a partial last name (at least first 2 characters) in the step 1 edit box 

and press enter. The Reader combo box drop down will be the populated with the list of matches 

against the last name string from the edit box. The 1st match in the list (alphabetically) will default as the 

selection.  

Activate/Deactivate Privileges 

To activate/deactivate a privilege, select that node and click the Activate/Deactivate button (the 

button’s text will read Activate when the Reader tree view’s selected node is on an inactive Privilege and 

will read Deactivate when on an Active Privilege. When Deactivating an Active Privilege, the all Child 

Privilege will be deactivated as well. All Deactivated Privileges will have an icon change for their given 

node (Grayed out globe for Acquisition Site, Gray Pause button for Specialty Index, Procedure index). 
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The Privilege that is explicitly deactivated will have the text ‘[INACTIVE]’ appended to it. To Activate the 

Privilege and its child Privileges select the appropriate node and click Activate. The Privilege and all child 

privilege will become Active with the icon changing (colored in globe, green play button) and the 

‘[INACTIVE]’ text removed.  NOTE: If a child Privilege had been explicitly deactivated at an earlier time, it 

will remain so, even after the parent privilege is activated until it is explicitly activated.  

Cloning TeleReader Profiles  

Once a reader profile is set up, a site administrator can clone the profile to provide consistent profiles 
for other readers who perform the same function.  

Clone Reader Function Readers/Privileges Screen 

 

To clone a reader profile, from the TeleReader Configurator main screen click the Reading Site Setup 
button. The Reader Setup screen opens. 

From the Readers/Privileges tree view, select the reader whose privileges you want to clone. The reader 
is highlighted in blue. Click the Clone Reader button.  
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The Select Reader(s) to be Cloned screen opens.  

Select Readers to Be Cloned Screen 

 

 

The Privileges to be cloned panel displays the site name and lists the privileges that will be cloned to 

new readers. In the Enter Part of Last Name field, enter at least the first two characters of the last name 

of the reader to which you want to clone the selected privileges. The list of readers with no assigned 

privileges whose names match the search string populates in the Available Readers panel. Use the 

forward arrow ( ) and backward arrow ( ) to move readers from the Available Readers panel to the 

Selected Readers panel and vice versa. You may also move readers back and forth by double-clicking on 

the reader name, or selecting the name and clicking the [Ctrl] button and then the [Enter] button on 

your keyboard. 
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NOTE: If TeleReader Configurator does not find readers whose names match the search string 

you enter into the Enter Part of Last Name field, a No Matches Found dialog displays. To return 

to the previous screen and enter another search string, click the [OK] button. 

No Matches Found Dialog 

 

 
NOTE: You cannot clone privileges from a reader to another reader who already has a reader 
profile. You must delete that reader’s privileges first. To delete a reader’s privileges, follow the 
steps in the section titled Deleting a Reader or a Reader Privilege.  

Complete the selection of readers to whom you want to clone the privileges. When the Selected 

Readers panel is populated, the [OK] button activates.  

 Click [Cancel] to cancel the clone or  

 Click [OK] to continue. 

A confirmation of cloning action dialog opens, listing the readers for whom profiles will be created with 
the cloned profile. 
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Global Settings 

TeleReader Global System Settings Screen 

 

Currently the only setting that is relevant to both the Acquisition Site and Reading Site is the TeleReader 

Timeout setting, field #131 of the IMAGING SITE PARAMETERS file (#2006.1). This setting specifies how 

long the TeleReader application can stand idle on a desktop before it closes. 
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System Help 

Message Log 

 

The System log can be accessed from the TeleReader Configurator Main Screen. Under the Help Menu 

select Message Log. The system log shows Login information, Inserts/Deletes/Updates and Retrievals 

from VistA database files and SOAP calls to Imaging Exchange Web Service (done when adding a new 

Acquisition Site in the Add Acquisition Site screen to check that the Primary Site is a valid primary site.  
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About Box 

The About box can be accessed from the TeleReader Configurator Main Screen. Under the Help Menu 

select About... The About box shows information about the application, such as version number and 

compilation date. 
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Field Help Text 

 

 

All of the Add/Edit screens have Field Text Help functionality. For any control (combo box, edit box, 

check box, list box) that is connected to a field in VistA file either click the question mark image to the 

right of the control or put focus on the control and press F1. A dialog will appear that contains 

information about the VistA file field such as a description of what data the field holds and allowable 

input values, such as max minutes allowed for TeleReader Timeout. 


